Avaya Solution & Interoperability Test Lab

Application Notes for Configuring Broadvox SIP Trunking
with Avaya IP Office Release 8.0 – Issue 1.0
Abstract
These Application Notes describe the steps necessary to configure Session Initiation Protocol
(SIP) Trunking between Broadvox and Avaya IP Office Release 8.0.
Broadvox SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the
Broadvox network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.
Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted in the Avaya Solutions
and Interoperability Test Lab, utilizing Broadvox SIP Trunk Services.
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1. Introduction
These Application Notes describe the steps necessary to configure Session Initiation Protocol
(SIP) Trunking between Broadvox and Avaya IP Office Release 8.0.
The Broadvox SIP Trunking service referenced within these Application Notes is positioned for
customers that have an IP-PBX or IP-based network equipment with SIP functionality, but need
a form of IP transport and local services to complete their solution.
Broadvox SIP Trunking will enable delivery of origination and termination of local, longdistance and toll-free traffic across a single broadband connection. A SIP signaling interface will
be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results
The general test approach was to connect a simulated enterprise site to the Broadvox SIP
Trunking service via the public Internet and exercise the features and functionality listed in
Section 2.1. The simulated enterprise site was comprised of Avaya IP Office and various Avaya
endpoints.
DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
test plan focuses on exercising standards-based interfaces pertinent to the interoperability of the
tested products and their functionalities. DevConnect Compliance Testing is not intended to
substitute for full product performance or feature testing performed by DevConnect members,
nor is it to be construed as an endorsement by Avaya of the suitability or completeness of a
DevConnect member’s solution.

2.1. Interoperability Compliance Testing
To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:
Response to SIP OPTIONS queries
Incoming PSTN calls to various phone types including H.323, SIP, digital, and analog
telephones at the enterprise. All inbound PSTN calls were routed to the enterprise across
the SIP trunk from the service provider.
Outgoing PSTN calls to various phone types including H.323, SIP, digital, and analog
telephones at the enterprise. All outgoing PSTN calls were routed to the PSTN across the
SIP trunk to the service provider.
Inbound and outbound PSTN calls to/from Avaya IP Office Softphone.
Various call types including: local, long distance, outbound toll-free, and local directory
assistance.
Codec G.711MU and G.729A.
G.711 Fax.
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Caller ID presentation and Caller ID restriction.
DTMF transmission using RFC 2833.
Voicemail navigation using DTMF for inbound and outbound calls.
User features such as hold and resume, transfer, and conference.
Off-net call forwarding and twinning.

2.2. Test Results
Interoperability testing of Broadvox SIP Trunking was completed with successful results for all
test cases with the exception of the observations/limitations described below.
T.38 Fax – The use of T.38 Fax did not fully pass compliance testing. While inbound
faxing worked fine over T.38, outbound faxing was intermittently successful and is not
guaranteed to work. Broadvox does not always Re-INVITE for T.38 on outbound faxes,
and if no Re-INVITE is sent, the outbound fax fails. This is a current limitation of the
Broadvox SIP trunk platform. It was also observed that outbound faxing will work and
inbound faxing fails if IP Office is set for G.711 faxing on the SIP Line (see Section 5.7).
SIP Network REFER with Blind Transfer – When Avaya IP Office is configured to
have REFER support on the SIP Line set to “Always” and an extension receives a call
from a PSTN number and attempts to blind transfer the call to another PSTN extension,
the transfer will complete but the call may not be released from the system as IP Office is
sending its own WAN IP address in the Refer-To header. A Maintenance Request was
submitted for this against IP Office R8.0(43).

2.3. Support
For technical support on Broadvox SIP Trunking, contact Broadvox using the Customer Service
links at www.broadvox.com/.
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3. Reference Configuration
Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to Broadvox SIP Trunking.
Located at the enterprise site is an Avaya IP Office 500v2. The LAN port of Avaya IP Office is
connected to the enterprise LAN while the WAN port (LAN2) is connected to the public
network. Endpoints include an Avaya 1616 IP telephone (with H.323 firmware), an Avaya
1120E IP telephone (with SIP firmware), an Avaya 1408 Digital telephone, an Analog telephone,
and an Avaya IP Office Softphone. The site also has a Windows 2003 Server running Avaya
Voicemail Pro for voicemail and Avaya IP Office Manager to configure the Avaya IP.

Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed.
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In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that SIP and RTP traffic
between the service provider and the Avaya IP Office must be allowed to pass through these
devices.

4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:
Avaya Telephony Components
Equipment
Avaya IP Office 500v2
Avaya Voicemail Pro
Avaya IP Office Manager
Avaya Analog Telephone
Avaya 1408 Digital Telephone
Avaya 1616-I Telephone (H.323)
Avaya 1140E IP Telephone (SIP)
Avaya IP Office Softphone
Venta Fax
Equipment
FreeSWITCH

Release
Release 8.0 (43)
Release 8.0 (80029)
Release 10.0 (43)
N/A
ha1616ual_300B
Release 04.01.13.00
Release 3.2.3.15 64595
6.2.80.203
Broadvox SIP Trunking
Release
Version 1.0.head git-9425cfa

5. Configure Avaya IP Office
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start → Programs → IP Office → Manager to launch the
application. A screen that includes the following in the center may be displayed:

Select Open Configuration from System, or navigate to File → Open Configuration and then
select the proper Avaya IP Office system from the pop-up window. Log in with the appropriate
credentials. The appearance of the IP Office Manager can be customized using the View menu.
In the screens presented in this section, the View menu was configured to show the Navigation
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pane on the left side, the Group pane in the center, and the Details pane on the right side. These
panes will be referenced throughout the Avaya IP Office configuration. All licensing and feature
configuration that is not directly related to the interface with the service provider (such as
twinning and IP Office Softphone support) is assumed to already be in place.

5.1. Licensing and Physical Hardware
The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.
To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane and SIP Trunk Channels in the Group pane. In the Details pane, confirm a
valid license exists with sufficient Instances (trunk channels).

If Avaya IP Telephones will be used as is the case in these Application Notes, verify the Avaya
IP endpoints license. Click License in the Navigation pane and Avaya IP endpoints in the
Group pane. In the Details pane, confirm a valid license exists with sufficient Instances.
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In the sample configuration, looking at the IP Office 500 V2 from left to right, the first module is
a Combination Card. This module has 6 Digital Station ports, 2 Analog Station ports, 4 Analog
Trunk ports and 10 VCM channels. The second module is a legacy Nortel module TCM8. The
VCM32 is a Voice Compression Module supporting VoIP codecs. An IP Office hardware
configuration with a VCM component is necessary to support SIP trunking.
The following screen shows the modules in the IP Office used in the sample configuration. To
access such a screen, select Control Unit in the Navigation pane. The modules appear in the
Group pane. In the screen below, IP 500 V2 is selected in the Group pane, revealing additional
information about the IP 500 V2 in the Details pane.
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5.2. LAN2 Settings
In the sample configuration the WAN port (LAN2) was used to connect the Avaya IP Office to
the public network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500
V2. To access the LAN2 settings, first navigate to System in the Navigation Pane and then
navigate to the LAN2 → LAN Settings tab in the Details Pane. Set the IP Address field to the
IP address assigned to the Avaya IP Office WAN port. Set the IP Mask field to the mask used
on the public network. All other parameters should be set according to customer requirements.
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. Under RTP Keepalives set the Scope to RTP, the Initial
keepalives to Enabled and the Periodic timeout to 2. Enabling this will prevent the loss of
speech path on calls forwarded across the SIP trunk. These settings instruct Avaya IP Office to
send RTP keepalive packets every 2 seconds from the establishment of the connection. This will
start media flowing from the far-end endpoint in those cases where the far-end endpoint is
waiting to receive media before it starts to send media of its own. The RTP Port Number
Range can be customized to a specific range of receive ports for the RTP media. Based on this
setting, Avaya IP Office would request RTP media be sent to a UDP port in the configurable
range for calls using LAN2. Avaya IP Office can also be configured to mark the Differentiated
Services Code Point (DSCP) in the IP Header with specific values to support Quality of Services
policies for both signaling and media. The DSCP field is the value used for media and the SIG
DSCP field is the value used for signaling. The specific values used for the compliance test are
shown in the example below and are also the default values. All other parameters should be set
according to customer requirements.
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On the Network Topology tab in the Details Pane, configure the following parameters:
Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet.
Set Binding Refresh Time (seconds) to 60. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.
Set Public IP Address to the IP address of the Avaya IP Office WAN port.
Set the Public Port to 5060.
All other parameters should be set according to customer requirements.
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5.3. Voicemail Settings
On the Voicemail tab in the Details Pane, configure the SIP Settings section. The SIP Name
and Contact are set to one of the DID numbers assigned to the enterprise from Broadvox. The
SIP Display Name (Alias) parameter can optionally be configured with a descriptive name.
Uncheck the Anonymous box to allow the Voicemail Caller ID information to be sent to the
network.
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5.4. System Telephony Settings
On the Telephony tab in the Details Pane, uncheck the Inhibit Off-Switch Forward/Transfer
box to allow call forwarding and call transfer to the PSTN via the service provider across the SIP
trunk. If for security reasons incoming calls should not be allowed to transfer back to the PSTN
then leave this setting checked.

5.5. Twinning Calling Party Settings
To view or change Twinning settings, select the Twinning tab as shown in the following screen.
The Send original calling party information for Mobile Twinning box is not checked in the
sample configuration, and the Calling party information for Mobile Twinning is left blank.
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5.6. IP Route
Navigate to IP Route in the left Navigation Pane, and then right-click on the Group Pane to
select New (not shown). Create a default route with the following parameters:
Set IP Address and IP Mask to 0.0.0.0.
Set Gateway IP Address to the IP Address of the default router to reach Broadvox.
Set Destination to LAN2 from the pull-down menu.
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5.7. SIP Line
A SIP line is needed to establish the SIP connection between Avaya IP Office and Broadvox SIP
Trunking. To create a SIP line, begin by navigating to Line in the Navigation Pane. Right-click
in the Group Pane and select New → SIP Line (not shown).

5.7.1. SIP Line – SIP Line Tab
On the SIP Line tab in the Details Pane, configure the parameters as shown below.
Set ITSP Domain Name to the WAN IP address of IP Office.
Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.5, IP Office will include the Diversion Header for calls that are directed via
Mobile Twinning out the SIP Line to Broadvox. It will also include the Diversion
Header for calls that are call forwarded or transferred out the SIP Line.
Check REFER Support and set both the Incoming and Outgoing fields to Always. This
enables the use of the SIP REFER method for call forwarding and transfers. There was a
limitation with Blind Transfer call scenarios when REFER Support is enabled, see
Section 2.2 for details.
Check the In Service box. This makes the trunk available for incoming and outgoing
calls.
Check the Check OOS box. With this option selected, IP Office will use the SIP
OPTIONS method to periodically check the SIP Line. The interval at which SIP
OPTIONS are sent by IP Office is determined by the Binding Refresh Time for LAN2,
as shown in Section 5.2.
Default values may be used for all other parameters.
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5.7.2. SIP Line - Transport Tab
Select the Transport tab. Set the parameters as shown below.
Set ITSP Proxy Address to the IP address or FQDN of the Broadvox SIP proxy.
Set Layer 4 Protocol to UDP.
Set Use Network Topology Info to the network port configured in Section 5.2.
Set the Send Port to 5060.
Default values may be used for all other parameters.
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5.7.3. SIP Line - SIP Credentials Tab
SIP Credentials are used to register the SIP Trunk with a service provider that requires SIP
Registration. The parameters below were used to Register the SIP Trunk with Broadvox. SIP
Credentials are unique per customer and therefore customers must contact Broadvox to get the
proper registration credentials for their deployment.
Select the SIP Credentials tab, then click the Add button and the New Channel area will appear
at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click
the Edit… button. In the example screen below, a previously configured entry is edited. The
entry was created with the parameters shown below:
Set the User name, Authentication Name, and Contact fields to the registration string
provided by Broadvox. This is generally a 10 digit telephone number like 7325554489 as
shown below.
In the Password field, enter the registration password provided by Broadvox.
In the Expiry (mins) field, enter the time in minutes until the registration expires.
Check the Registration required field as Registration is required for Broadvox SIP
trunking service.
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5.7.4. SIP Line - SIP URI Tab
A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit… button. In the example screen below, a previously configured entry
is edited. The entry was created with the parameters shown below:
Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting
allows calls on this line whose SIP URI matches the number set in the SIP tab of any
User as shown in Section 5.9.
Select the Registration value that was configured above in Section 5.7.3.
Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).
Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

ALW; Reviewed:
SPOC 8/10/2012

Solution & Interoperability Test Lab Application Notes
©2012 Avaya Inc. All Rights Reserved.

18 of 38
Bvox-SIPT_IPO8

5.7.5. SIP Line - VoIP Tab
Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below.
Set the Codec Selection field to Custom to allow the specific codec selection to be
different from the system default. To modify, click on a codec and use the arrow keys to
move it to the Selected column and to change the order of preference. For compliance
testing G.729(a) was the first choice with G.711 ULAW second.
Uncheck the VoIP Silence Suppression box.
Check the Re-invite Supported box.
Set the Fax Transport Support to T38. See Section 2.2 for additional fax considerations
and limitations.
Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.
Default values may be used for all other parameters.
Click the OK button at the bottom of the page.
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5.8. Short Codes
Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
on Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in
the Details Pane, configure the parameters as shown below.
In the Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.
Set Feature to Dial. This is the action that the short code will perform.
Set Telephone Number to N“@208.1.1.229”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The IP address 208.1.1.229 represents the IP address of the
Broadvox SIP proxy (NOTE: The IP address value should be obtained from Broadvox as
the IP address listed here is for the compliance test environment).
Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.7.34. This short code will use this line group when placing the
outbound call.
Click the OK button at the bottom of the page.
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The simple 9N; short code previously illustrated does not provide a means of alternate routing if
the configured Broadvox SIP Line is out of service or temporarily not responding. When
alternate routing options and/or more customized analysis of the digits following the short code
are desired, the Automatic Route Selection (ARS) feature may be used. In the following
example screen, the short code 8N is illustrated for access to ARS. When the Avaya IP Office
user dials 8 plus any number N, rather than being directed to a specific Line Group Id, the call
is directed to 50: Main, configurable via ARS. See Section 5.11 for example ARS route
configuration for 50: Main as well as a backup route.

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”. In the case of the SIP Line to Broadvox
documented in these Application Notes, when a user dials *67 plus any number N, IP Office will
include the user’s telephone number in the P-Asserted-Identity (PAI) header along with
“Privacy: Id”. Broadvox will allow the call due to the presence of a valid DID in the PAI header,
but will prevent presentation of the caller id to the called PSTN destination.
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The following screen illustrates a short code that acts like a feature access code rather than a
means to access a SIP Line. In this case, the Code FNE31 is defined for Feature FNE Service
to Telephone Number 31 (Mobile Call Control). This short code will be used as means to allow
a Broadvox DID to be programmed to route directly to this feature, via inclusion of this short
code as the destination of an Incoming Call Route. See Section 5.10. This feature is used to
provide dial tone to twinned mobile devices (e.g., cell phone) directly from IP Office; once dial
tone is received the user can perform dialing actions including making calls and activating Short
Codes.
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5.9. User
Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.7. To configure these settings, first navigate to User in the Navigation
Pane, and then click on the User to be modified in the Group Pane. Select the SIP tab in the
Details Pane. The values entered for the SIP Name and Contact fields are populated as the user
part of the SIP URI in the From and Contact headers for outgoing SIP trunk calls and allow
matching of the SIP URI for incoming calls without having to enter this number as an explicit
SIP URI for the SIP line. The example below shows the settings for User H323 1616 Extension
301. The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from Broadvox. The SIP Display Name (Alias) parameter can optionally be configured with a
descriptive name. If all calls involving this user and SIP Line should be considered private, then
the Anonymous box may be checked to withhold the user’s information from the network.
Click the OK button at the bottom of the page.
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The following screen shows the Mobility tab for User H323 1616 Extension 301. The Mobility
Features and Mobile Twinning boxes are checked. The Twinned Mobile Number field is
configured with the number to dial to reach the twinned mobile telephone over the SIP trunk, in
this case 917205558022. Other options can be set according to customer requirements.
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5.10. Incoming Call Route
An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider
(NOTE: If the SIP tabs of various Users are configured with their respective DID information,
then populating the Incoming Call Routes may not be necessary). To create an incoming call
route, right-click Incoming Call Routes in the Navigation Pane and select New (not shown).
On the Standard tab of the Details Pane, enter the parameters as shown below.
Set the Bearer Capability to Any Voice.
Set the Line Group Id to the incoming line group of the SIP line defined in Section
5.7.3.
Set the Incoming Number to the incoming number on which this route should match.
Matching is right to left.
Default values can be used for all other fields.
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On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button at the bottom of the page.
In this example, incoming calls to
7325554489 on line 17 are routed to extension 301.
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Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in
Figure 1 are omitted here, but can be configured in the same fashion.
In the screen shown below, the incoming call route for Incoming Number 7325551985 is
illustrated. The Line Group Id is 17, matching the Incoming Group field configured in the SIP
URI tab in Section 5.7.4.

When configuring an Incoming Call Route, the Destination field can be manually configured
with a number such as a short code, or certain keywords available from the pull-down menu. For
example, the following Destinations tab for an incoming call route contains the Destination
FNE31 entered manually. FNE31 is the short code for FNE Service, as shown in Section 5.8.
An incoming call to 732-555-1985 will be delivered directly to internal dial tone from the IP
Office, allowing the caller to perform dialing actions including making calls and activating Short
Codes. The incoming caller ID must match the Twinned Mobile Number entered in the User
Mobility tab (Section 5.9); otherwise the IP Office responds with a 486 Busy Here and the caller
will hear a busy tone.
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5.11. ARS and Alternate Routing
While detailed coverage of ARS is beyond the scope of these Application Notes, this section
includes basic ARS screen illustrations and considerations. ARS is shown here mainly to
illustrate alternate routing should the SIP Line be out of service or temporarily not responding.
Optionally, Automatic Route Selection (ARS) can be used rather than the simple 9N; short code
approach documented in Section 5.8. With ARS, secondary dial tone can be provided after the
access code, time-based routing criteria can be introduced, and alternate routing can be specified
so that a call can re-route automatically if the primary route or outgoing line group is not
available. ARS also facilitates more specific dialed telephone number matching, enabling
immediate routing and alternate treatment for different types of numbers following the access
code. For example, if all local and long distance calls should use the SIP Line preferentially, but
service numbers should prefer a different outgoing line group, ARS can be used to distinguish
between the two call patterns.
To add a new ARS route, right-click ARS in the Navigation pane and select New (not shown).
To view or edit an existing ARS route, select ARS in the Navigation pane and select the
appropriate route name in the Group pane (not shown).
The following screen shows an example ARS configuration for the route named Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in
the form. If the In Service box is un-checked, calls are routed to the ARS route name specified
in the Out of Service Route parameter. IP Office short codes may also be defined to allow an
ARS route to be disabled or enabled from a telephone. The configurable provisioning of an Out
of Service Route and the means to manually activate the Out of Service Route can be helpful for
scheduled maintenance or other known service-affecting events for the primary route.
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Assuming the primary route is in-service, the number passed from the short code used to access
ARS (e.g., 8N in Section 5.8) can be further analyzed to direct the call to a specific Line Group
ID. Per the example screen above, if the user dialed 8-1-303-555-1682, the call would be
directed to Line Group 17, configured in Section 5.7. If Line Group 17 cannot be used, the call
can automatically route to the route name configured in the Additional Route parameter in the
lower right of the screen, e.g. 51: Backup. Since alternate routing can be considered a privilege
not available to all callers, IP Office can control access to the alternate route by comparing the
calling user’s priority to the value in the Alternate Route Priority Level field.

5.12. Privacy/Anonymous Calls
For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use either the P-PreferredIdentity (PPI) or P-Asserted-Identity (PAI) header to pass the actual calling party information for
authentication and billing. By default, Avaya IP Office will use PPI for privacy. For the
compliance test, PAI was used for the purposes of privacy.
To configure Avaya IP Office to use PAI for privacy calls, navigate to User in the Navigation
Pane, then NoUser in the Group Pane. Select the Source Numbers tab in the Details Pane.
Click the Add button.

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below. Click OK at the bottom of the screen (not shown).
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5.13. Save Configuration
Navigate to File → Save Configuration (not shown) in the menu bar at the top of the screen to
save the configuration performed in the preceding sections.
The following screen will appear with either Merge or Immediate selected, based on the nature
of the configuration changes made since the last save. Note that clicking OK may cause a
service disruption (especially in the case where the Configuration Reboot Mode is Immediate).
Click OK if desired.
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6. Broadvox SIP Trunking Configuration
Broadvox is responsible for the configuration of Broadvox SIP Trunking. The customer will
need to provide the IP address or FQDN used to reach the Avaya IP Office at the enterprise.
Broadvox will provide the customer the necessary information to configure the Avaya IP Office
SIP connection to Broadvox including:
IP address or FQDN of the Broadvox SIP proxy
Supported codecs
DID numbers
All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices.
This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

6.1. System Status
The System Status application is used to monitor and troubleshoot IP Office. Use the System
Status application to verify the state of the SIP trunk. System Status can be accessed from Start
→Programs →IP Office →System Status. Alternatively, System Status can be accessed by
typing the URL http://ipaddress, where ipaddress is the IP address of the IP Office LAN1
interface.
The following screen shows an example Logon screen. Enter the IP Office IP address in the
Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

Select the Alarms tab and verify that no alarms are active on the SIP line.
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6.2. Monitor
The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start →Programs →IP Office →Monitor. The application allows the
monitored information to be customized.
The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the trace
with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the
desired color (not shown).
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As an example only, the following shows a portion of the monitoring window for an outbound
call from extension 302, whose DID is 864-555-1234, calling out to the PSTN via the Broadvox
IP Trunking Service. The telephone user dialed 9-1-303-555-4321. NOTE: This was not from
the compliance test for these Application Notes but is an example from another system.

7. Conclusion
These Application Notes describe the configuration necessary to connect Avaya IP Office 8.0 to
the Broadvox SIP Trunking service. Broadvox SIP Trunking is a SIP-based Voice over IP
solution for customers ranging from small businesses to large enterprises. It provides a flexible,
cost-saving alternative to traditional hardwired telephony trunks. Broadvox SIP Trunking passed
compliance testing. Please refer to Section 2.2 for any exceptions.
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8. Additional References
This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.
[1] IP Office 8.0 IP Office Basic Addition Installation, Document Number 15-601042, Issue 25c,
April 27, 2012
[2] IP Office Release 8.0 Manager 10.0, Document Number 15-601011, Issue 28h, March 28
2012
[3] IP Office System Status Application, Document Number 15-601758, Issue 06b, November 12,
2011
[4] IP Office 8.0 Administering Voicemail Pro, Document Number 15-601063, Issue 27b, April
06 2012
[5] IP Office IP Office System Monitor, Document Number 15-601019, Issue 02b, November 28
2008
Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ or http://support.avaya.com
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9. Appendix - SIP Line Template
Avaya IP Office Release 8.0 supports a SIP Line Template (in xml format) that can be created
from an existing configuration and imported into a new installation to simplify configuration
procedures as well as to reduce potential configuration errors.
Note that not all of the configuration information is included in the SIP Line Template,
particularly items relevant to a specific installation environment. Therefore, it is critical that the
SIP Line configuration be verified/updated after a template has been imported and additional
configuration be supplemented using Section 5.7 in these Application Notes as a reference.
The SIP Line Template created from the configuration as documented in these Application Notes
is as follows:
<?xml version="1.0" encoding="utf-8" ?>
<Template xmlns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20120615</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>Broadvox</DescriptiveName>
<ITSPDomainName>205.1.1.19</ITSPDomainName>
<SendCallerID>CallerIDDIV</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>1</ReferSupportIncoming>
<ReferSupportOutgoing>1</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired>
<UseTelURI>false</UseTelURI>
<CheckOOS>true</CheckOOS>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority>SystemDefault</LineNamePriority>
<ITSPProxy>208.1.1.229</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>G729A8K</CompressionMode>
<UseAdvVoiceCodecPrefs>true</UseAdvVoiceCodecPrefs>
<AdvCodecPref>G.729(a) 8K CS-ACELP,G.711 ULAW 64K</AdvCodecPref>
<CallInitiationTimeout>6</CallInitiationTimeout>
<DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_T38FB</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
<CodecLockdown>false</CodecLockdown>
<Rel100Supported>true</Rel100Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
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<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>
<SIPCredentials>
<Expiry>60</Expiry>
<RegistrationRequired>true</RegistrationRequired>
</SIPCredentials>
</Template>

1. On the PC where IP Office Manager was installed, copy and paste the above template
into a text document named US_Broadvox_SIPTrunk.xml (the file must be named
EXACTLY as shown). Move the .xml file to the IP Office Manager template directory
(C:\Program Files\Avaya\IP Office\Manager\Templates).
2. Import the template into an IP Office installation by creating a new SIP Line as shown in
the screenshot below. In the Navigation Pane on the left, right-click on Line then
navigate to New → New SIP Trunk From Template:

3. Verify that United States is automatically populated for Country and Broadvox is
automatically populated for Service Provider in the resulting Template Type Selection
screen as shown below. Click Create new SIP Trunk to finish the importing process.
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